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Personal Bus. Block Style Letter - Open Punctuation Example
Using a letterhead will eliminate the return address.  An Enclosure notation at the bottom of

the letter means there is something in the envelope in addition to the letter.

Open Punctuation:  No punctuation after the salutation or after the complimentary close.

A Letter of Application usually consists of three paragraphs:  Paragraph 1 states the job

being applied for, Paragraph 2 details the skills you possess and how you are qualified for

the job being applied for, and Paragraph 3 requests an interview and states that the resume

is enclosed.

1234 My Street Address

Garden City, KS  67846

May 2, 2004

MR ROBERT EMPLOYER PRESIDENT

JONES MANUFACTURING COMPANY

1400 MAIN AVENUE

CLEVELAND OH  25000

Dear Mr. Employer

Please consider my application for the position of typist which was advertised

in the Garden City Telegram.  I have just graduated from Garden City High

School where I took several business education courses.  I have studied

typing for two years and can type accurately at the rate of 60 words per

minute.

In addition to my business education, I have held several part-time jobs that

have provided experience in this field.  I worked as a clerical helper with light

typing duties for the Marco Company during the past two summers.  I also

addressed envelopes on a part-time basis for the Sims Mailing Company for

a period of six months last year.

I would appreciate an opportunity to discuss this job with you at your

convenience.  My resume is enclosed for your review.  You may contact me

by mail at the address above or telephone me at 555-1111.

Sincerely

Amy Student

Enclosure

1" Side

Margins
1" Side

Margins

Make the top and bottom margins approximately the same.

All capital letters and

no punctuation on the

inside address

ONLY.

QS - 4 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

QS - 4 returns (Signature area)

DS - 2 returns

DS - 2 returns



4

Personal Business Modified Block Style Letter

with Mixed Punctuation Example
Using a letterhead would eliminate the return address.

An Enclosure notation at the bottom of the letter means there is something in

the envelope in addition to the letter.

Mixed Punctuation:  A colon (:) after the salutation and a comma (,) after the

complimentary close.

1234 My Street Address

Garden City, KS  67846

May 2, 2004

MR ROBERT EMPLOYER PRESIDENT

JONES MANUFACTURING COMPANY

1400 MAIN AVENUE

CLEVELAND OH  25000

Dear Mr. Employer:

Please consider my application for the position of typist which

was advertised in the Garden City Telegram.  I have just

graduated from Garden City High School where I took several

business education courses.  I have studied typing for two years

and can type accurately at the rate of 60 words per minute.

In addition to my business education, I have held several part-

time jobs that have provided experience in this field.  I worked

as a clerical helper with light typing duties for the Marco

Company during the past two summers.  I also addressed envelopes

on a part-time basis for the Sims Mailing Company for a period of

six months last year.

I would appreciate an opportunity to discuss this job with you at

your convenience.  My resume is enclosed for your review.  You

may contact me by mail at the address above or telephone me at

555-1111.

Sincerely,

Amy Student

Enclosure

1" Side

Margins

Modified Block has a tab set at about 3" from the left

margin so that the return address, date, complimentary

close, and typed name can be indented.

Make the top and bottom margins approximately the same.

All capital letters

and no punctuation

on the inside address

ONLY.

1" Side

Margins

QS - 4 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

QS - 4 returns (Signature area)

DS - 2 returns
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Business Block Style Letter with Open Punctuation Example
Business Block Style letters should be typed on letterhead stationery.

Open Punctuation:  No punctuation after the salutation or after the

complimentary close.

May 2, 2004

MRS GREAT TEACHER

GARDEN CITY HIGH SCHOOL

1412 N MAIN

GARDEN CITY KS  67846

Dear Mrs. Teacher

Miss Amy Student, a graduate of Garden City High School, has applied for a

position with our company as a typist.  She has given us your name and her

permission to ask you about her skills and attendance while in your class.

Will you, therefore, please verify that Amy Student was in your class and

respond as you desire about her performance in class.

Thank you, Mrs. Teacher.

Sincerely

Mr. Robert Employer

President

xx

You should allow for a top margin of approximately 2 1/2" for the letterhead.

JONES MANUFACTURING COMPANY
1400 Main Avenue

Cleveland, OH  25000

QS - 4 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

QS - 4 returns (Signature area)

DS - 2 returns
Typist's Initials

1" Side

Margins
1" Side

Margins

All capital letters and

no punctuation on the

inside address ONLY.
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Envelope Example

An envelope is typed in all capital letters with no punctuation.  The return

address can be typed in all caps, or in both caps and lowercase.  This is in

compliance with the Postal Service.

   AMY STUDENT

  1234 MY STREET ADDRESS

  GARDEN CITY KS  67846

MR ROBERT EMPLOYER PRESIDENT

JONES MANUFACTURING COMPANY

1400 MAIN AVENUE

CLEVELAND OH  25000

Memorandum Example
Memos use 1" side margins and a 1" top margin.  This type of correspondence

is used interoffice and is not mailed; therefore, there is no return address, inside

address, salutation, or complimentary close.  Paragraphs are block style, single

spaced with a double space between paragraphs.

TO: Fellow Worker

FROM: Amy Student

DATE: May 2, 1997

SUBJECT: What the Memo Is About

The body of the memo is single spaced and paragraphs are not

indented.  Memos are sent interoffice, only to those people in

the same organization or business.  Memos are never mailed.  They

are delivered within the organization by courier.

Memos can be to a single person or a group of people.  They can

be from the writer or typed by another for a fellow worker.  The

subject is always a summary of what the memo is about.

There is no inside address, salutation, or complimentary close in

a memo.  The TO, FROM, DATE, and SUBJECT data are aligned at

the next available tab stop following the longest heading entry (usually

1" in from the left margin).

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns

DS - 2 returns
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Resumes should be limited to one page in length if at all possible.

On a resume you are not required to list personal information such as

birthdate, sex, marital status, health, or race.

It is generally a good idea to have references available upon request or to list

three references including name, title, address, and phone number for each.

Those three references should not be relatives and you should ask for permis-

sion to use them as references.  Teachers, administrators, ministers, local

business leaders, and former employers make good references.

Sections on a resume can be arranged in the order that best promotes you for

the job.

Additional sections can be added or deleted to best promote you for the job.

Amy Student

1234 My Street Address

Garden City, KS  67846

email address

316/275-0000

Objective:

State your career objective in two or three sentences.

Education:

List your most recent education first followed by the previous

ones only through high school.  Include the name of the school,

address, city, state, and zip code, dates of degrees obtained,

and honors earned.

Work Experience/Skills:

List your most recent work experience first followed by previous

ones.  Include name of employer, address, phone number, and

jobs held.

Honors/Awards:

List any honors or awards earned.

Community Activities:

List any activities you are involved in.

References:

Available upon request.

OR

List three people and include their name, title, address, and

phone number.

Sample Resume
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Outline Format for both Oral and Written Presentations
(Note:  Oral Presentation Outlines MUST be structured as follows)

                                                                                                               Student 1

Amy Student

Mr. Jones

Speech Period 4

23 March 2004

  I. Introduction

A. Attention-getting device.  May be a quote, illustration,

shocking statement, or rhetorical question.

B. Rationale for speech.  Why did you choose the topic--

why is it important?

C. Thesis.

1. Purpose:  I will inform/persuade you about...."

2. Preview/signposting:  "My three main ideas are...."

 II. Body

A. Main idea number 1.  (Transition/Introduce Main Idea Here)

1. Supporting material for main idea 1.

2. Supporting material for main idea 1.

3. Supporting material for main idea 1.

B. Main idea number 2.  (Transition/Introduce Main Idea Here)

1. Supporting material for main idea 2.

2. Supporting material for main idea 2.

3. Supporting material for main idea 2.

C. Main idea number 3.  (Transition/Introduce Main Idea Here)

1. Supporting material for main idea 3.

2. Supporting material for main idea 3.

3. Supporting material for main idea 3.

III. Conclusion

A. Summary:  review and/or pull together the most important

points.

B. Postview:  restate your original main ideas.

C. Final Thought:  This will be the last thing you say to the

audience, so plan it well.  End clearly!

Some things to remember:

*  Everything on the outline should be a complete sentence except the words

"introduction," "body," and "conclusion."

*  Sources must be cited in MLA format.

*  List sources on a Works Cited page.  Follow the Works Cited instructions.
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Document Format Instructions

Setting Up an MLA Document in Microsoft Word

Change Margins:

Go to the File menu.

Choose Page Setup.

Change the Right and Left Margins to 1".

Do not make any other changes.

Create the Header:

Go to the View menu.

Choose Headers and Footers.

Click the Right Alignment button on the toolbar.

Type your Last Name and a space.  Do not hit Enter.

Click on the # symbol (pound sign).

Check to make sure the font & size matches those of the document.

Click Close.

Set Document for Double Spacing:

Go to the Format menu.

Choose Paragraph.

Under Line Spacing:  change to Double.

Click OK.

Turn OFF Auto Outline:

Go to the Tools menu.

Choose AutoCorrect.

Go to the AutoFormat As You Type tab.

Uncheck Automatic Bulleted Lists and Automatic Numbered Lists.

Click OK.

Hanging Indent for the Works Cited Page:  (indents the second line

of the entry)

Go to the Format menu.

Choose Paragraph.

Under Special:  choose Hanging.

Be sure under By:  that it is .5".

Click OK.

Indent for Quoted Lines of 5 or Longer:

Go to the Format menu.

Choose Paragraph.

Under Indentation, Change the Left:  to 1".

Click OK.
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Amy Student

Mr. Heinrichs

English II Period 3

27 November 1996

Centered Title

       The body of the paper starts on this line.  If you continue in your pursuit of

the correct MLA format, your paper will meet the mechanical requirements at

Garden City High School.  That attention to detail will help any paper.  Not only

will you enhance your English grade, but you will be prepared to follow any

documentation style in future classes and in other institutions.

       Please notice that the margins are one inch and that the paper is double-

spaced throughout.  Your font size should be no larger than 10 or 12 point.  This

is a standard font size.  Do not use script or other elaborate font types to try to

enhance your paper.  Your ideas should be good enough without them.  If they

are not, nothing will disguise that fact.

       Indent five spaces to begin all paragraphs and do not triple-space between

paragraphs.  Do not capitalize the entire title, underline the title, or use quotation

marks.  Do not boldface or italicize it.  The header begins on the first page and

Essay Format and Guidelines

includes your last name and the page number.  That is all you need for the

header—no comma or the word “page” or punctuation.

       Make sure you leave a one inch margin at the bottom as well as the top of

your paper.

Student 2

Student 1

Heading information is double spaced and begins 1" from the top.

(The 1" is your top margin.)

Regular double spacing before and after the title.

Header on each page;

Last Name & Page Number



11

PERIODICALS:

Signed Article in a Magazine and 2nd entry by the same author:

Tully, Shawn.  “The Universal Teenager.”  Fortune 4 Apr. 1994:  14-16.

---.  "Michael Jordan Retires."  Sports Illustrated 16 May 1998:  24-30.

Unsigned Article in a Magazine:

“Do School Uniforms Help?”  The New Republic 28 Mar. 1994:  9.

Signed Article in a Newspaper:

Bloom, Jim.  “Schools in Transition.”  Garden City Telegram 10 June 1994, 4A.

Unsigned Article in a Newspaper:

"President Impeached."  Garden City Telegram 5 April 1999, 1A.

Works Cited Examples  (Note Spacing and Punctuation)

BOOKS:

One Author:

Jones, Sam.  The Life and Times of a Student.  Fargo, ND:  Harcourt, 1991.

Two or Three Authors:

Smith, Carrie, and Mary Jones.  Rappin’ It Up.  Boston:  Prentice Hall, 1995.

More than Three Authors:

Alvarez, Juanita, et al.  Cooking in America.  Chicago:  Signet, 1988.

An Article in a Reference Book:  (with author)

Farquar, Mary.  “Marriage.”  Encyclopedia Britannica, 1996 ed.

An Article in a Reference Book:  (without author)

“Trees.”  Collier’s Encyclopedia, 1993 ed.

A Textbook:

Nash, Gary B.  "Chapter 10:  The Great Depression."  American Odyssey:  The

       United States in the 20th Century.  New York:  Glencoe, 1994:  324 - 51.

A Work in an Anthology/Collection:

Green, Mark.  "The Pro-PAC Backlash:  When Money Talks, Is It Democracy?"

       Points of View.  Ed. Robert E. Diclerico and Allan S. Hammock.  3rd ed.

       Guildford, CT:  Dushkin Publishing Group, 1986:  156-160.

Bible:

(NO Works Cited entry is necessary on the Works Cited page.  However, in the

body of the paper the Bible reference would be:)

The Bible speaks of the sacrifice God made to save the world (John 3:16).

"For God so loved the world, that he gave his only begotten Son..." (John 3:16).

(Note:  Two spaces follow the author, title, and city or state.)

(The three hyphens show that there is more than one work by the same writer.)
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Internet-World Wide Web Examples:

If Author is Known:

Abilock, Debbie.  "Research on a Complex Topic."  Nueva Library Help.  8 Aug.

       1996.  3 Sept. 1999 <http://www.nueva.pvt.k12.ca.us/~debbie/library/

       research/advice.html>.

If Author is Unknown:

"Planning for Resource Shortages."  Earth Care 10 Apr. 1996.  6 June 1999

       <http://www.berline.cc.stanfordu.ca/pub/Ecology/Index.html/>.

Works Cited Examples  (Note Spacing and Punctuation)

Computer Resources:

CD Rom Encyclopedia:

“Flowers.”  Collier’s Electronic Encyclopedia, 1996 ed.

CD ROM Periodical Access:  SIRS

Storms, Edmund.  "Warming Up to Cold Fusion."  Technology Today May/June

       1994.  pp 19 - 29.  SIRS.  CD ROM.

Online Periodical Access:  ProQuest, InfoQuest, etc.

Stempel, Douglas.  "Loving our Heritage."  Annapolis Reporter 3 July 1992:  12.

       ProQuest.  Online.  13 Nov. 1999.

(Note to students:  This is the date you found it on the Internet.)

OTHER:

Personal Interview:

Brooks, Sarah.  Personal Interview.  15 July 1996.

Survey:

Survey.  30 GCHS U.S. History Students, 3rd hour.  12 Dec. 1997.

Class Notes:

Springston, Brad.  Class Notes.  U.S. History, 5th hour.  Fall 1999.

Video:

The Speeches of Martin Luther King.  Dir. John Houseman.  MPI Home Video,

       1993.

Author or Editor Web Page Title Site Title

Post date or Last Update

Date you found it on the Internet

Electronic Address

(Note:  Two spaces follow the author and title..)
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Internet/World Wide Web Examples:  (continued)

Professional Site:

Bowker, Samuel T.  "Cyberspace:  Debate on Research Use."  University NET

       Scope.  12 Sept. 1996.  University of Michigan - Ann Arbor.  5 Oct. 1999

       <http://www.university.net.scope/infoscience.umichigan.edu/research/cyber/>.

Personal Site:  (Note:  The date is the date you found it on the Internet)

Burton, Francis.  Home page.  11 Nov. 1999 <http://www.lang.uutah.cc:5454/

       ~francis/index.html>.

Archived Posting to a Discussion List:

Matthews, Robert.  "Legally Banning Puppy Mills."  Online Posting.  15 Nov.

       1996.  People Caring for Animals Conference.  20 Feb. 1999 <http://www.vet.

       ucd.ca/animalscience/pcac/PUB_MILL.txt>.

Scholarly Project:

New England Folklore Project.  Ed. Marcia Farnsworth.  May 1997.  Indiana U.

       12 Sept. 1999 <http://www.indiana.edu/~mtf/nefp/>.

Book in a Scholarly Project:

Arndt, Jefferson.  Tales from Penobscot Bay.  New York:  Fawcett, 1985.  New

       England Folklore Project.  Ed.  Marcia Farnsworth.  May 1997.  Indiana U.

       20 Nov. 1999 <http://www.indiana.edu/~mtf/nefp/arndt/tales.html>.

Articles in Reference Databases:

"Astronomy."  Collier's Online.  Vers. 97.2.2. 1997.  Collier's Encyclopedia.

       14 Jan. 1999 <http://www.ce.com:362>.

Carlyle, Lois.  "Weeping for the Universe?"  Rev. of Explointing the Cosmos, by

       Charles Lindsey.  Houston Herald 15 Nov. 1997, sec. B:6.  Human Rights

       Opinions Online.  1997.  Human Rights Publications, Inc. 17 Nov. 1999

       <http://search.humanrightspub.com/books/97/11/15/reviews/

       971115.15carlyle.html>.

Book in an Electronic Text Repository:

Austen, Jane.  Sense and Sensibility.  Ed. Ronald Nielsen.  Harmondsworth:  Pen-

       guin, 1962.  Cambridge Text Archive.  16 Feb. 1999 <ftp://etext.cam.ac.uk>.

E-Mail Message:  (Note:  The first date is the date the message was sent)

Toshner, David.  <david@toshner.net>.  22 Feb. 1999.  E-mail to the author.  25

       Feb. 1999.

Works Cited Examples  (Note Spacing and Punctuation)

(Note:  The second date is the date of the reply)
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Plagiarism Is Cheating!

Imagine yourself on the job.  You work hard for twenty hours on a project for the boss

while she is out of town.  When she gets back, you go to her to show her your work, and you

find out that a co-worker has taken all the credit and the pay bonus for it!  How would you feel?

Angry?  Cheated?  How do you think the boss will react when she finds out your co-worker

lied?  Probably, that person will be fired.

Cheating on the job and cheating on a paper involve the same basic abuse, using

someone else’s work--an author’s or another researcher’s--as your own.  This is WRONG!  The

consequences can be severe.

According to the student handbook, “Any student that is caught cheating on any

school assignment will receive a failing grade for that assignment. . . .  Further incidents of

cheating in the same class or different classes or in the same year or different years can result in

ISS and/or OSS or long term expulsion.”

Just as in the workplace, your boss would no longer trust you if you cheat, your

teacher(s) may not presume you to be honest.  All your work could be checked for plagiarism.

 How Do You Know If You Are Plagiarizing?

Plagiarism — the act of presenting someone else’s IDEAS as your own.

 Three types of plagiarism:

word-for-word plagiarism — a writer repeats the exact words of a source without giving the

necessary credit.

This includes:

copying from the encyclopedias, books, magazines, or any other printed matter

without using quotation marks AND crediting the source.

quoting from non-written sources like interviews, recordings or videos without

crediting the source and using quotation marks.

paraphrase plagiarism — a researcher says basically the same thing as an original source with

just a few words changed.

This includes:

changing a paragraph from third person (he, she, it) to first person (I, me, mine) in order

to make the ideas seem like your own.

changing a passage to your own words but not giving credit to the original writer.

changing a passage to your own words by following the same sentence structure as

the original writer.

spot plagiarism — using a source’s key words or phrases as your own without using quotation

marks AND giving credit.

You do NOT have to give a source for ideas that are “common knowledge.”   Information is

considered common knowledge if most people already know it.  For example, that there are 365

days in the year is common knowledge.  The fact that it rained 210 days in Seattle during 1990 is

not.

If in doubt, give credit to the source.

adapted from Writer’s Inc. School To Work.
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Research Paper Example

Jonathan Kirchoff

Mr. Thompson/Mr. Germes

H. Eng. III/AP US History Period 3

5 March 2001

The Truth of Pearl Harbor

       "Yesterday, Dec. 7, 1941--a date which will live in infamy--the

United States of America was suddenly and deliberately attacked by

naval and air forces of the Empire of Japan," said President

Roosevelt as he addressed Congress.  The attack on Pearl Harbor

was not organized in one month by the Japanese.  It required

months of preparation to make sure that not one discrete detail had

been overlooked.  But was the attack provoked by authorities of the

United States?  Pearl Harbor was a day of abomination that was

planned by President Roosevelt who thought that the lives lost and

the damage wrought was worth the price to bring the unwilling

citizens of the United Sates into World War II.

       In the mid-1940s, a poll showed that being involved in Europe's

wars was the exact opposite of what the American citizens wanted.

However, President Roosevelt and other leaders felt that if Germany

was successful, the nation's security would be endangered.  There-

fore, they believed that America needed to oppose the Nazis

(Stinnett 7).  Knowing that the majority of Americans didn't want to

be engaged in war, Congress would not and could not be persuaded

to declare war without an incident that would provoke the American

public.  This led Roosevelt to employ a new foreign policy written by

Lieutenant Commander Arthur H. McCollum that would trigger Japan

to commit an "overt act of war" hostile to the United States

(Stinnett 6).  McCollum's plan, as follows, supported eight measures

that would initiate the Japanese to attack.

Kirchoff 1

Header on each page;

Last Name & Page

Number

The

subject of

this report

is summed

up in the

thesis

statement

at the end

of the first

para-

graph.

Heading

information

is

double

spaced

and begins

1"

from the

top.

(The 1" is

your top

margin.)

Regular

double

spacing

before

and after

the

title.
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A.  Make an arrangement with Britain for the use of

British bases in the Pacific, particularly Singapore.

B.  Make an arrangement with Holland for the use of

base facilities and acquisition of supplies in the Dutch

East Indies [now Indonesia].

C.  Give all possible aid to the Chinese government of

Chiang Kai-shek.

D.  Send a division of long-range heavy cruisers to the

Orient, Philippines, or Singapore.

E.  Send two divisions of submarines to the Orient.

F.  Keep the main strength of the US Fleet, now in the

Pacific, in the vicinity of the Hawaiian Islands.

G.  Insist that the Dutch refuse to grant Japanese

demands for undue economic concessions, particularly

oil.

H.  Competely embargo all trade with Japan, in collabo-

ration with a similar embargo imposed by the British

Empire. (Stinnett 8)

In regard to Action D, Roosevelt said, "I don't mind losing one or

two cruisers, but do not take a chance on losing five or six"

(Stinnett 9).

       Was there any opposition to this treacherous plan?  At lunch

together, Admiral James O. Richardson disagreed with how

Roosevelt was willing to jeopardize a Navy ship to provoke an

attack which, in turn, would lead to letting the Japanese attack,

killing innocent people.  For this opposition, Richardson was

removed from his position as commander-in-chief (Stinnett 10).

Most of those who were involved in the scheme were men of the

military, of Roosevelt's choice.  If they followed his orders, he would

Kirchoff 2

Header on each page;

Last Name & Page

Number

Quoted

infor-

mation of

5 lines or

more are

double

spaced

and

indented

1" from

the

left

margin

only.



17

not have to use his authority as he had to with Richardson (Willey).

He also cautiously positioned naval officers who would not interfere

with the "provocation" plan (Stinnett 11).  Among those who aided

in the conspiracy with Roosevelt were Hull, Stimson, Navy Secre-

tary Knox, General Marshall, Admiral Stark, and Harry Hopkins.

Many times, aides of those mentioned above begged their advisors

to send some sort of warnng to prevent an attack on Pearl Harbor.

These pleas were voiced in vain as their advisors ignored them or

wasted time, allowing the attack to still take place.  Admiral Stark's

aides pleaded with him to send a warning to Pearl Harbor, but he

did nothing.  Marshall delayed sending any kind of messages by

reading it over and over again, and even then he refused to use the

quickest means of communication to send the message to Hawaii.

In fact, his warning was received in Hawaii six hours after the

bombing took place (Willey).

       The United States received or intercepted many messages

and warnings concerning an attack.  Of those, very few important

ones were forwarded to fleet commanders stationed in Hawaii to

prepare for the attack.  "Washington intelligence officials ignored

federal laws and intercepted the Japanese messages, but kept the

information from Admiral Kimmel and General Short" (Day).

However, Kimmel was sent a message that warned him of an

upcoming attack.  It was sent by the Navy Department on Novem-

ber 27, 1941, and read, "This dispatch is to be considered a war

warning.  Negotiations with Japan looking toward stabilization of

conditions in the Pacific have ceased and an aggressive move by

Japan is expected within the next few days" (Shapiro 51).  No

other messages were sent to prepare Hawaii for an attack even

when information was coming to Washington that told leaders the

Kirchoff 3

Header on each page;

Last Name & Page

Number
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exact date on which it would occur.  On December 4, General

Thorpe, stationed in Java, sent four messages warning of an attack

upon Pearl Harbor, but he was stopped when officials in Washington

quickly silenced him (Willey).  By the beginnng of December,

Japan's plan was completely known by American cryptographers,

yet these messages were never sent to Admiral Kimmel or General

Short, leaving Pearl Harbor open to a surprise attack (Stinnett 115).

       On the evening of December 6, 1941, Roosevelt stated when

he returned to his 34 dinner guests, "The war starts tomorrow"

(Willey)  He was right when he said this, but the rest of the world

did not know what significance the next day would hold.  The

morning of Sunday, December 7, 1941, seemed like an ordinary

Sunday to many people who were sleeping in, going to church,

reading the morning paper, or enjoying themselves on the beach

having a picnic (Dunnahoo 11).  This

same morning, unknown to all at

Pearl Harbor, the Japanese force

including six carriers (with 423

airplanes aboard) with fast battle-

ships, two heavy cruisers, a light

cruiser, eight destroyers, three oilers,

and a supply ship only 230 miles away and preparing for take off

(Toland 8).  The plan was to send a first wave of 43 fighter planes,

49 high-level bombers and 51 dive bombers, and 40 torpedo-laden

planes (Toland 10).  At 7:02 a.m., Oahu's northern shore radar

station picked up the Japanese fleet but disregarded the report

knowing that there were American B-17 planes expected from the

west coast.  At 7:15, the second wave of 167 aircraft took off from

Japanese carriers.  At 7:55, the first wave began destruction from
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the Northwest as they attacked the 96 American ships docked at

Pearl Harbor.  An hour and five minutes later, the second wave of

planes from the Northeast began to finish up on what the first wave

missed ("Pearl").  At 1:50 p.m. on an unusually brisk day in Wash-

ington, officials received a message from Admiral Kimmel that there

was an "AIR RAID ON PEARL HARBOR THIS IS NOT A DRILL"

(Toland 12).

       This attack brought a devastating blow upon the United States.

As Jonathan Daniels, press secretary, put it, "The blow was heavier

than he [Roosevelt] hoped it would necessarily be...But the risks paid

off; even the loss was worth the price..." (Willey).  The price was

2,335 military lives (1,102 of which were from the USS Arizona), 68

civilian lives, and 1,178 wounded.  Eighteen ships were either sunk or

damaged, and of 394 aircraft grounded at Wheeler, Bellows, and

Hickam airfields, 188 were ruined and 159 were damaged ("Pearl").

This seems like a costly price to bring America into war, but

Roosevelt did not think so.  When Secretary Knox told President

Roosevelt about the attack, he was unsurprised and expressed "great

relief," as was noticed by Hopkins.  His wife noticed that he became

"in a way more serene."  He told Lord Halifax, "Most of the fleet was

at sea...none of their newer ships were in harbor."  Admiral Bloch

obviously felt the same when he said, "The Japanese only destroyed

a lot of old hardware.  In a sense they did us a favor" (Willey).  To

others, the attack was a complete shock.  Admiral Raymond

Spruance, commander of five cruisers, was shocked at the level of

damage as he came into the harbor on the following Monday.  He

"choked with emotion, tears running down his cheeks, [as] he tried to

tell his shocked wife and daughter what he had seen and felt"

(Toland 17).  Many struggled to understand what had just happened
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to them as "Fear paralyzed people....In fear and pain, people

begged to die....Some were in shock and did not recognize their

best friends standing beside them....his friends screamed, sobbed,

or stared into space around him" (Dunnahoo 29).

       As a result of this attack, Roosevelt was confident that Con-

gress would declare war with Japan.  He said:

The facts of yesterday speak for themselves.  The people

of the United States have already formed their opinions

and will understand the implications to the very life and

safety of our nation.  As commander in chief of the Army

and Navy, I have directed that all measures be taken for

our defense....I ask that the Congress declare that since

the unprovoked and dastardly attack by Japan on Sunday,

Dec. 7, a state of war has existed between the United

States and the Japanese empire. (Eakins "Infamous" 17)

December 11 brought the United States into a now global conflict

when Italy and Germany officially declared war against the United

States (Portillo).  The attack and the declaration of war by Germany

and Italy only unified the country as it was determined to be protec-

tive against any more attacks (Dunnahoo 39).  "The nation geared

itself for mobilizatin of its people and its entire industrial capacity."

(Day)  Production goals were increased to staggering amounts in

1942.  "All of the nation's activities--farming, manufacturing, mining,

trade, labor, investment, communications, even education and

cultural undertakings--were in some fashion brought under new and

enlarged controls" (Eakins "Pearl").  New industries to mass

produce ships, planes, and other vehicles were created from huge

funds raised by the nation.  Because of the fear of Asian spying,

"Americans also committed an act of intolerance" ("Japan").
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Around 120,000 Japanese-Americans in California were stripped

from their homes and relocated in 10 inadequate "relocation

centers."  However, espionage never surfaced as there were

many Japanese-Americans who fought for or aided the American

cause (Eakins "Infamous").  The attack on Pearl Harbor may

have been "...the greatest military defeat in American history"

(Clausen 22), but it "...[thrust] America into World War II and a

new role in global politics" (Eakins "Pearl") which later led to the

bombings of Hiroshima and Nagasaki to end World War II

(Portillo).

       Pearl Harbor was a day "which will live in infamy" that was

planned by President Roosevelt who thought that the lives and

the damage sustained was worth the price to bring the uncommit-

ted citizens of the United States into World War II.  His speech

hid a double-meaning of how his day of infamy started when he

decided to lead the Japanese to attack the United States.  To

think a United States President, behind the Americans' backs,

would risk putting thousands of lives in danger just to drag a

reluctant nation into war brings the word "traitor" to mind.  This

information was excellently concealed from the public's knowl-

edge because of how carefully Roosevelt carried out his plans,

and whom he could involve in this plot as is seen with the

Richardson incident.  As Willey put it, "...the Navy at Pearl were

Roosevelt's bait, the oil embargo was his stick, the end of

negotiations was the tripwire in Roosevelt's game of shame--a

game of death for so many."
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Note-taking

Continue to look for information related to your thesis statement.  To do this

simply head to the library or media center and dig in.  As you find good sources of informa-

tion, keep track of them on your computer or on 3- by 5-inch cards.  Arrange the cards in

alphabetical order by the authors' last names.  If you don't know the name of an author,

alphabetize by the first word in the title (not including A, An, or The).  Either number or

letter each entry in your computer list, or number or letter each card in the upper right-

hand corner.

As you begin reading the material listed in your bibliography, take notes and write

down quotations related to your specific thesis.

Keep notes on cards of the same size and style (4- by 6- inch cards are recom

mended).

Write down important details and quotations, along with the page numbers where

this information can be found.  Also place the number or letter of the related

bibliography card in the upper right-hand corner.

Place quotation marks around word-for-word quotations.

Use the ellipses (...) when you leave words out of a quotation.  Use brackets

around words you add to a quotation.

Look up unfamiliar words.  If you find that a particular word is important, copy its

definition onto a note card.

Give each card a descriptive heading (a word or phrase to highlight the main idea

of that note card:  Torturing of Wolves).

Note:  As you make personal observations during the research process, write freely in a

journal.  This will help you clarify your thinking.

This is a good time to develop your skimming talents.  Look over the table of

contents, the index, and a sample paragraph or two before deciding to read a source in its

entirety.

Summarize To summarize, reduce what you have read to a few important points using

your own words.

Paraphrase To paraphrase, restate what you have read using your own words.  Use

this method when you are trying to retrace the thinking of one of your sources.  Put

quotations marks around key words or phrases you borrow directly from the sources.

Quote Directly To quote someone directly, record the statement or idea word for word and

put quotation marks before and after.

Write for College.  Wilmington, Massachusetts:  Write Source, 1997.

or   A

or   A



24

6+1 Trait Writing Rubric
Rating Guide for Writing Assignments

  I. Ideas and Content

5 Paper: The paper is clear, focused and holds the reader's attention.

3 Paper: The paper is clear and focused even though the development is

limited.

1 Paper: The paper has no clear purpose.

 II. Organization

5 Paper: The order or structure is very easy to follow.

3 Paper: The order or structure moves the reader without undue confusion.

1 Paper: The paper lacks a clear sense of direction.  Ideas which seem

random make the paper hard to follow.

III. Voice

5 Paper: The writer speaks directly to the reader.  The writer is involved in

the text.

3 Paper: The writer seems sincere but not involved.

1 Paper: The writer is uninvolved with the topic and/or audience; conse

quently, the paper is flat, mechanical, lifeless.

 IV. Word Choice

5 Paper Words make the message clear in an interesting, precise, and

natural way.

3 Paper The words are functional, but the message gets across.

1 Paper The writer struggles with a limited vocabulary and has a hard

time finding the right words to get the meaning across.

  V. Sentence Fluency

5 Paper: Sentences are well built with consistently strong and varied

structure and length.

3 Paper: The paper is efficient, businesslike, or mechanical.  There is some

variation in sentence length and structure.

1 Paper: The paper is difficult to follow or read aloud.  Sentences tend to

 be choppy, incomplete, rambling, or awkward.

 VI. Writing Conventions

5 Paper: No glaring errors in spelling, mechanics, or grammar are found in

the paper.  The paper is easy to read and understand.

3 Paper: The writer has reasonable control over a limited range of

conventions.

1 Paper: Errors in conventions distract the reader and make reading

difficult.

VII. Presentation (Optional)

5 Paper: Form and presentation of the text enhances the reader's ability to

understand.

3 Paper: The writer's message is understandable.

1 Paper: The reader receives a garbled message.
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5-Trait Technical Writing Rubric
Rating Guide for Technical Writing Assignments

  I. Clarity (Organization)

5 Paper: Important points come first.  Reporter's questions answered.

Specific, denotative words used.

3 Paper: Some important points are delayed.  Some reporter's

questions assumed understood.  Some vague, connotative

words used.

1 Paper: Important points are delayed or absent.  Some reporter's

questions never answered.  Many vague, connotative words

used.

 II. Conciseness (Sentence Fluency/Word Choice)

5 Paper: Words are generally one or two syllables.  Sentences aver-

age 10-12 words.  Paragraphs do not exceed six typed lines.

3 Paper: Longer words used when shorter words exist.  Sentences

average 15-20 words.  Some paragraphs exceed six typed

lines.

1 Paper: Longer words are commonplace.  Sentences average over 20

words.  Paragraphs often exceed six typed lines.

III. Accessible Document Design (Ideas and Content)

5 Paper: Highlighting techniques emphasize main points to help

access.  Highlighting techniques not overused.

3 Paper: Some main points are highlighted.  Information is usually

accessible.

1 Paper: Highlighting is not used.  Information is not accessible.

Highlighting is overused.

 IV. Audience Recognition (Voice)

5 Paper Writer defines all high-tech terms.  Writer considers audience

needs.  Writer uses pronouns to involve audience.

3 Paper Writer usually defines high-tech terms.  Writer usually

considers audience needs.  Writer often involves audience

through pronouns.

1 Paper Writer does not define high-tech terms.  Writer does not

consider audience needs.  Writer never uses pronouns to

involve an audience.

  V. Accuracy (Writing Conventions)

5 Paper: Writer uses correct punctuation, correct spelling, and correct

grammar and usage.

3 Paper: Punctuation is usually correct.  Spelling is usually correct.

Grammar and usage are somewhat flawed.

1 Paper: Punctuation is often incorrect.  Spelling is often incorrect.

Excessive grammar and usage errors distort the message.


